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C- Axis Editor

Overview

The Axis Editor is the main editing tool used anywhere content and imagery is placed

throughout the website.
Use Case(s)

Website Admins and Editors will use the Axis Editor when updating content and imagery on the

website.

Accessing the Tool

Click to Edit: Access the Axis Editor by clicking on any Click to Edit button on the website.

Click to Edit:

Entry peint to access the Axis
_ _ Editor. Wherever Click to
Edits are visible, is where
content and imagery can be
Monday Tuesday, Wednesday managed via the Axis Editor.

calck o e - s

Editor Tools

The Quick Tab Toolbar and the Menu Bar of the Axis Editor contain the main tools that will be

used to edit content.
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{ Auxis Editor - Google Chrome

[ www.grandkeyclub.com/A_Master/NET/AxisEditor/DialogContainerEditor.aspx?CHT=2&GID=si23FA 1wLY/KgXqcZxN8cxmq5gar1jzhV2Myv 1yLGyNg &

Page Edit View Insert Format Table Tools Help

= M i G|[m

v||galamor‘cl¢r..vH42px v‘ BJ UA-& | EEXNE | 43 - 9

Welcome back, #H#FMEMNAMEH#H# \o

/" Design | € HTML @ preview

H1 > RemoveElement

Quick Tab Toolbar

The Quick Tab Toolbar contains commonly used icons and options to format content.

H 9-®- 4 Ga E|‘E| |Pa'agra|:h St Y| |F:|ntNa|T|e

Save: Sets changes live immediately.

-

Y||Real...v| B 7 U A~ 3~ :

Undo/Redo: Reverse to previous step, or re-do previous undone step. Click the small

down-arrow to the right of the buttons, to see (and optionally select) a list of the latest steps to

undo or redo.
‘) ~ v

Cut/Copy: Cut and Copy content within the editor.

$ 43
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Paste as Plain Text: Code is carried over from outside sources, which is not compatible with
the website design. Instead of pasting content directly into the Axis Editor, use the Paste as

Plain Text function to paste content. This tool will strip formatting so the proper formatting can

be applied.

£

=

Style Tags: Font options that were determined during the design phase. Apply Style Tags to

change the font throughout the content.

Normal '| ‘Arial, Helveti... "
Normal

HEADING 1

HEADING 2

HEADING 3

Font Options: Additional font options that may be used.

Arial, Helveti... «| | 14px =
Avrial
Century Gothic

Courier New

Garamond

Georgia

Impact

Lucida Sans Unicode
Palatino Linotype
Tahoma

Times New Roman

Trebuchet MS
Verdana
More Fonts...

Image Explorer: Opens the Image Explorer for adding imagery to the content area.
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Insert Table: Allows for a table to be added.

Rl R I

I I
I I
I I
I I
I I
I I
OO OOO00E
HE NN
B Table Wizard

]

Insert Hyperlink: Used to insert various hyperlinks such as: event links, article links, document
links, page links, or to remove hyperlinks.

Hyperlink
Event Link
Article Link
Document Link
Link to Page

Special Links

ReLER®®

Link to Listing

Remove Link

L
Lt

Insert Snippet: Snippets are dynamically populated based on information in the Directory and

Accounting system. Snippets may be used to personalize pages (Examples: Member Name,
Emaill Address, Minumum Left Unspent).

Site Name
Page Title
Member Name
{Current Date

More...
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Format Stripper: Used to remove hidden style codes from the content.

_f Strip All Formatting
o Strip Css Formatting
if  Strip Font Elements

of  Strip Span Elements

wf  Strip Word Formatting

Menu Bar

The Menu Bar contains commonly used actions and additional ways to access formatting tools
when working in the Editor.

Fage Edit View Insert Format Table Tools Help

Page: Here we can save our work, access logs, and save drafts and templates.

Edit  View

Wy Save as Draft
m Save as Template
[:', Revisions

:} Privileges

Page Info

*‘}4 Print
o

Save and Exit

Save as Draft: Save page changes for later. This will not publish the changes live, and allows the

page to be worked on at a later date. Once saved, Drafts are stored (and retrievable) under
Revisions.

Page Edit View

E Page Logs
Wy Save as Draft I [ .
J Logs ]l Drafts l Auto Saved Unpublished
m Save adgfemplate .
) Click a Record to View Html ]
[:, Revisions -~
Name / Update Time =
» Privileges
2 = > Emily Latham [CE] g 9/13/2016 9:51:44 AM
» Page Info % Brittany Hudson [CE] 6/27/2013 11:30:40 AM
& Print % Andy Strittmatter [CE] 1/24/2012 2:11:50 PM
“\!‘ Save and Exit ¥ Zachary Larabee [CE] 11/21/2011 11:26:59 AM
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Save as Template: Save Pages as Templates. A Template is a pre-formatted file that serves
as a starting point for a new document in the future. Oftentimes, templates are used in

conjunction with Email.

Page Edit Vieo

Ky Save as Draft

E] Save as Template

E', Revisions
='} Privileges
> Page Info
.@ Print
= Save and Exit
To save new template, name the template, click on the desired folder location to save template,

and then click Save Template.

Save as New Template [ ]
Save Template
Template Mame | Test Template |
Folder

= My Saved
[ Archives
] Automated Member Communications
-3 brunch
- (] CE Templates
. -] Dining

E—@)
] Golf Events

Revisions: Shows previous version of the page changes. May be used to load an older version

(] Themed

Save Template

of content to the page. This is where we access Drafts and Logs after we Save as Draft.
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-

Edit  View

Insert Format Tabde Tools

ky Save as Draft Heading 1 - 'Gec,o(
Save as Template :
| £ Revisions - - /

=} Privileges b I Drafts I

L Page Info Auto Saved

ﬁ Print Linpubis hed

Il Save and Exit ¥

(@

=) Page Logs L

j Logs Drafts Auto Saved 1'\. Unpubhshed ]

Click a Record to View Hitml

Name

Emily Latham [CE]

MM MM

Brittany Hudson [CE]
Andy Strittmatter [CE]
Zachary Larabee [CE]

Update Time =

8/13/2016 9:51:44 AM
6/27/2013 11:30:40 AM
1/24/2012 2:11:50 PM
1172172011 11:26:59 AM

Format: Alternate ways to address font styling.

Format Table Tools

B Bold
I ltalic
U  Underline
9 Style
Font
Size

Strikethrough

x~[r

Superscript

X

Subscript

B

-
[

Alignment

List Style

e
I

= Increase Indent

dka

= Decrease Indent
Line Spacing
Strip Formatting
ity Style Wizard

Colors

Convert to Uppercase

Convert to Lowercase

Help
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Tables: Different Options for working within tables.

Table Tools Help

i

B EEFE

HEYE®RE

Insert Row Above

Insert Row Below

Delete Row

Insert Column to the Left
Insert Column to the Right

Delete Column

Merge Cells Vertically
Split Cell Horizontally
Split Cell Vertically
Delete Cell

Cell Properties

Table Properties

Adding Content

Inserting Content

Content can be added by directly typing into the editor, or by copying from an outside source
and pasting into the editor. If copying from another source, please use the Paste as Plain Text

Function as detailed below.

Copy content from another source like Word by highlighting the text and using CONTROL + C to

Copy.

@ H 7

FILE HOME INSERT DESIG

r-

Paste

-

3{, Cut
E‘@ Copy
¥ Farmat Painter

Clipboard [F]

GS REVIEW VIEW ACROBAT

.le=s=1a
== 2 T AaBbCcDc A
Ig' Q-_v ThNormal | TI

Font [P Paragraph o [P

Grand Key's Seaside Spa & Salon offers a full-service, European-style spa with private freatment rooms, a relaxation area, sp
pool.

The Seaside Spa and Fitness Center brings healthy pleasures to your island experience. Whether you indulge in our signature 1

FITNESS
Grand Kev's Fitness Staff offers a diverse ranee of expertise. trainine and experience. All of our trainers are comimitted to de
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Go back to the Axis Editor, and open the Paste as Plain Text Function.

Page Edit View Insert Format 1

CIEAMER: ] RS
- X

Once the Paste as Plain Text Function is open, use CONTROL + V to paste the text into the
Paste as Plain Text Function. Then click Paste to insert the content into the Axis Editor.

Paste Plain Text ]

Please, use CTRL + V to paste below the content you would like to ke cleaned

Grand Key's Seaside Spa & Salon offers a full-service, European-style spa with private

meditation garden. Locker rooms feature separate facilities for each gender including
sauna, steam room, tanning garden, whirl pool and cold plunge pocl.

The Seaside Spa and Fitness Center brings healthy pleasures to your island experience.
Whether you indulge in our signature treatments, partake in a sunrise yoga practice cne
of our expert instructors or simply enjoy the amenities in our facility, your body, mind
and spirit will leave balanced and energized.

FITNESS
Grand Key's F't}"e/<_/;aff offers a diverse range of expertise, training and experience. Al ~

of our trainers afe committed to designing a personalized fitness plan that helps you

o o > I Paste || Cancel

P

Once the content is in the Axis Editor, highlight the text and apply various Style Tags as needed.

[3 old.grandkeyclub.com/A_Master/NET/AxisEditor/DialogContainerEditor.aspx?CHT=28u

Fage Edit View Insert Format Table Tools Help

= 9~ - % B (|| Norma v| |"_imes MNew ... '| | 16px v| B 7 U A~ iy~ =
B - Normal - :
Grand Kev's Seaside Spa & pean-style spa with private treatment
whirl pool and cold plunge g
The Seaside Spa and Fitness| HEADING 1 ; to vour island experience. Whether »
energized.
HEADING 2
FITNESS |
Grand Ke)fs Fitness Staff of . traming and experience. All of our t
/ HEADING 3

O

e Heading 1: typically used for Page Titles
e Heading 2-6: used for various sub-headings
e Normal: used main body text

10
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Inserting Images

Images must first be uploaded to the Image Explorer before they can be used on the website.

e Access the Image Explorer from the Quick Tab Toolbar or from the Menu Bar under Insert >
Image.

Quick Tab Toolbar Menu Bar

Format  Table

I L& Image I
I Table
________ & External Video
ET%' Q- F- 2 Link b
Snippet 3
[ Template b
= Horizontal Rule
] Page Break
9+ MNew Paragraph
e Choose the Folder in which your image is located.
e Double click on the Image Name to Insert onto page.
=) Image Explorer o @
[site Images e 2 E L Sy 8 & 3 W X3 H e
I Add New Category
563 Images [ (] [(»]  Pagesize:[25 +| 2 items in 1 pages

..... (2 2015 Valentines Day

..... [ 2015_mobileMasterimage ] Name & Dimensions Last Updated

----- 53 Article Thumbnails <

o Bar:|c1:rs 5:;(‘]1,(1:30' O ﬁ 1920 x 1200 3/31/2015 3:15:09 PM
----- [CD Board of Directors

2 Clubhouse photos g 500 x 250 3/31/2015 3:22:00 PM

----- 2 Cross Marketing

----- 22 Dining o /'
40D Golf

ﬂ@ Member Events
ﬂ@ Netcaddy Reservation S

eal tstate ‘h

D Renovation photos - 2010
ﬂEﬁ Staff Images

ﬂEﬁ x Archived

----- Cce System Images

o i

11
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Styling Images
Add styling Images such as wrap text and padding.

Right click on the Image > Image Properties

' Properties...

2 Image Map Editor

ﬂ View in Image Explorer

Choose Text Alignment to have content wrap around the image.

(=) Properties... [ ]

Choose Image | http://old.grandkeyclub.com/im |

Width px &a Height px
Image Alignment = 3 ) .+«

Border Color Border Width IIl i
=
=

Top

Alt Text

Title Text

Righ = Lefe |2 ex
|
|
|

Long Description

H
-~

Cancel

12
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Add Padding to create space between the image and content.
o Common Padding Sizes: 5px, 10px, 15px, 20px.

E Properties... E

Choose Image | http://old.grandkeyclub.com/im | |E|

Width px ea Height p)c

Image Alignment |E] '|
Border Color |& '| Border Width I:l px

Top px Bottom 153 px
Right px Left px

Alt Text | |

|
Long Description | |

Title Text

Below, we can see we have space, or Padding, between the image and the content.

FACILITIES

. = 4 ' Grand Key's
Seaside Spa &
Salon offers a
full-service,
European-style
spa with private
treatment rooms,
a relaxation area,
spa cuisine, a
Turkish Hammam
and an outdoor
> o meditation

garden. Locker rooms feature separate facilities for each gender including sauna, steam room,
tanning garden, whirl pool and cold plunge pool.

13
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Inserting Tables

Tables can be used to help align content. Most commonly used when adding lists in columns
such as contact information, tournament results, or document links.

e Click on the Table function from the Quick Tab Toolbar, or use the Menu Bar, Insert >
Table

Quick Tab Toolbar Menu Bar

Format  Table

Image

Table

External Video

Link 3

=l
=2
El3 - s 0- Z

Snippet »
Template »
Horizontal Rule

Page Break

New Paragraph

= E Il

e Choose the amount of rows and columns for the table and the table will automatically be
inserted on the page.

e

2z Table Wizard

=

e Click mouse inside cell of inserted table and start typing. Cell will expand.

d 9" &L

i Click on cell @nd start typing - cell will expand; |

---------------------------------------------------------

Normal /’ vl |branccn-g|'o... -
2

4 La

14
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Styling Tables

Right click on the inserted table, and choose Table Properties

--------------- -

Apply styling

E Table Wizard

TAm e - -mmom-—-o- ==

nd start typing - cell will expand;

i N La
'

Insert Row Above

Insert Row Below

Delete Row

Insert Column to the Left
Insert Column to the Right
Delete Column

Merge Cells Horizontally

Split Cell Horizontally
Split Cell Vertically
Delete Cell

Cell Froperties.

Table Properties

(2 T

to the Table or Cells.

E Table Wizard

& -
Style Builder: ot

Back Image:

Select All

[ Table Design l Table Properties l Cell Properties | Accessibility '\ | Tbepesan " TavleProperties | CellProperties | Accessiiiy |
o —C55 Class Layout Prev ell Properti
Height: l:l pixels, % No €55 Class Layout - Height: l:l pixels, %
Width: pixels, % Apply special formats to Width: l:l pixels, %
Heading Row Last Row Content
First Column Last Column aigrment. 7
Background
—Layout d S~
Color:
Cell Spacing: Preview Style Builder 4y
Cell Padding: Jan Felr Mar Total
7 ; s smamsge [ |
Alignment: &~ West £ 4 7 17 e[ ]
South 8 7 9 24 .
Background Color: - .
otal 21 18 21 50 [ no text wrapping

15
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e Adjust Table Width or Height by adding a percentage or pixels.
o lItis best to not assign a height as the table will grow with the amount of content
o Itis best to assign a 100% width to the table so it spans the full content area.

Table Wizard

Table Design I Teble Properties 1 ‘éﬁroperties Y"\ Accessibility \'\..
. . —C55 Class Layout
r—Dimension
Height: I pixels, % | Mo C55 Class Layout -
| Width: pixels, % I Apply special formats to
- Heading Row Last Row
'\ a First Column Last Column
—Layout
Cell Spacing: Preview :
Cell Padding: Jan Feb Mar Total
East 7 7 5 19
Alignment: 3§~
g x West 6 4 7 17
Background Color: &y ~ South 8 7 9 24
Total 21 18 21 60
Style Builder: o
| OK | | Cancel |

e Adjust Cell Width or Height by adding a percentage or pixels
o Useful when wanting each cell to have a fixed width or height

Table Design Y\.\ Table Properties T Cell Properties ! Accessibility \'\.,_
—Preview

r—Cell Properties

o / Height: I:I pixels, %

Content

8

Alignment:

Background

=
Color: =
Style Builder |[=

Back Image: l:l [

[ no text wrapping

) [ ¢
] ] il

Select All

16
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or

Apply content position to the table

Table Design | Table Properties

Cell Properties \ Accessibility \

—C5S Class Layout:

r—Dimensions
Height: |:| pixels, % | Ne C55 Class Layout hd
) = ; . Apply special formats to
Width: | 100 3] pixels, % PR =P
- 4| Heading Row 4| Last Row
4| First Column 41 Last Column
—Layout
Cell Spacing: Preview :
Cell Padding: Jan Feb Mar Total
East 7 5 19
Alignment: - /
? x West 6 7 17
Backqround Color: South 8 9 24
SRSHE Total 21 18 21 60
Btyle Builder:
Coemmonee | |
I | |
e Apply content position to the cells
[ Table Design \ Table Properties Cell Properties Accessibility \
—Preview —Cell Praperties
P
o Height: |:| pixels, %
Width: I:I pixels, %
Content
Alignment: x
Background EREHE
- &= 1SS
a tyle Builder [ E =
no text wrapping

Select All

17



C- Axis Editor

e Add padding to cells using the Style Builder option.

Cell Properties i Accessibility

o 1“““

r—Cell Properties

Height:
Width:

Centent

Alignment:

Background

Color:

a

|:| pixels, %
I:I pixels, %

I Style Builder

Back Image:

Id:

no text wrapping

] style Builder
Font U
Background ad Width : Ipx 'J
Text / Height Slex -
Layout #
rPadding Margin
Box [ 5ame for all [ 5ame for all
Border Top 5 : Ipx v] Top : Ipx v]
Lists Bottom : IPK 'I Bottom : IPX 'I
Left Tl 7 Left Tl 7
AN ighe Tl 7 Right ~lox -
o | oK Cancel |

Save/Publish Content

2

When finished editing, click Save to publish changes and exit the Editor.

BJI UA-&H- = EESEE 4 3

Grand Key's Seaside Spa & Salon offers a
uisine, a Turkish Hammam and an outdoor

sauna, steam room, tanning garden, whirl p

The Seasid 3 and Fitne enter brings

reatments, partake in a sunrise yoga praciu

mind and spirit will leave balanced and ener
Saving HTML

FITNE

Grand Key

Monday

Tuesday

3pn 10am - 6pm

18
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Best Practices

1. When copying content from an outside source, always use the Paste as Plain Text
function to strip outside formatting. This will ensure that the proper pre-defined font
options are applied to the content.

2. Using additional font options is not recommended as it is best to streamline content
font. It is best to only use the Style Tags option.

3. Resize and Crop Images prior to using imagery on the website to ensure the proper
dimensions rather than resizing on the page.

4. Remember to Save after edits are made or edits may be lost. Once Saved, the changes
will publish live.

19



